"Master Cuban Drummer Calixto Oviedo thoroughly demonstrates traditional and
contemporary Cuban rhythms on drum set and timbales from danzdn to timba!
Recorded, transcribed and produced by Kevin Moore, ‘Beyond Salsa Percussion’ is
authentic and easy to understand - a must for every drummer."

“El genial baterista cubano, Calixto Oviedo, demuestra los ritmos cubanos tradicionales
y contempordneos en la bateria y el timbal - desde el danzén tradicional a la timba de
ahora. Transcripcién, grabacién, y produccién por Kevin Moore, ‘Beyond Salsa
Percussion’ es auténtico y fdcil de comprender ... un método para todo baterista!”

Walfredo de los Reyes, Sr.

"Calixto Oviedo, para mi, representa el percusionista y drummer cubano con mayor
proyeccion e informacién internacional de su época. Coincidimos en la orquesta de
Pacho Alonso y le imprimié un sello moderno y especial al ritmo “pilén”. Después, en NG
La Banda, fue capaz de asumir la responsabilidad de llenar y llevar la seccién ritmica
de una agrupacion de mucho peso. Solamente hay que escuchar sus grabaciones como
“Echale limén”y “Santa palabra”. No he conocido a nadie con la capacidad de
memorizar diferentes repertorios como él Se puede dar el lujo de tocar sin ensayar con
cualquier orquesta cubana. Tiene memoria absoluta. Calixto es de los mds completos

musicos cubanos. Un respeto para mi hermanito.”

“For me, Calixto Oviedo is the most influential percussionist of his era. We played
together in Pacho Alonso’s group, where Calixto put his own special, modern stamp on
Pacho’s famous “pilon” rhythm. Later, when he joined NG La Banda, you only have to
listen to recordings like “Echale limén” and “Santa palabra” to hear how capably he
was able to drive that heavyweight rhythm section. I've never met anyone with Calixto’s
ability to memorize the entire repertoire of a band so quickly. He can play, without
rehearsal, with any Cuban orquesta. He has a photographic memory for rhythm. Calixto

is one of the most complete of all Cuban musicians. Props to my brother.”

Issac Delgado

"Calixto Oviedo is the sole creator of the latest grooves in popular Cuban music, what
we know as Timba, with the integration of timbales and drumset. Impeccable taste and
technique, combined with his knowledge of Afro-Cuban rhythms, make Calixto a
musician to follow. This book is a testimonial to all of that.”

Horacio “El Negro” Hernandez



“Calixto Oviedo is for me one of the biggest musicians to come off the island of Cuba in
recent years. I have had the opportunity to play with Calixto many times and hope to
continue playing with him in the future. I consider him to be a talented musician and a
great person to know ."”

Luis Conte

“Calixto es sin dudas un verdadero tesoro de nuestra musica cubana.”

“Calixto is, without a doubt, a tresaure of Cuban music.”

Carlos Caro

"Among Cuban drummers, Calixto Oviedo is the most innovative musician. [ learned all
about Cuban rhytms from him. Thank you Calixto!"

Akira Jimbo (Japan)

"Calixto Oviedo is the Elvin Jones of Cuban music."

Peter Suwalski (Denmark)

“Calixto Oviedo es un gran musico que ha sabido asimilar, no sélo las influencias de los
grandes bateristas afro-cubanos de generaciones anteriores (Barreto, Del Monte, de los
Reyes, etc.) sino también la de las luminarias del jazz y (Rich, Colaiuta), hasta crear su
propio estilo y convertirse a su vez en una referencia obligada para las nuevas
generaciones. Resulta, indiscutiblemente, uno de los creadores de los patrones ritmicos
de la musica cubana contemporanea, especialmente de los géneros asociados a la
Timba.”

“Calixto Oviedo is a great musician who has been able to assimilate not only the
influences of the great Afro-Cuban drummers of earlier generations (Barreto, Del
Monte, de los Reyes, etc.) but also of the jazz masters (Rich, Colaiuta), creating his own
style that has become, in and of itself, a standard for later generations. Calixto is
indisputably one of the creators of the rhythmic patterns of contemporary Cuban music,
especially in regard to timba and related genres.”

Juan de Marcos
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Introduction to the Series

How the Series is Organized and Sold

Each volume of Beyond Salsa Percussion consists of three separately sold products:
1) abook like this one with text and musical notation (hard-copy or eBook)
2) downloadable MP3 audio files of each musical example at full-speed and in slow motion

3) downloadable computer video files showing the Cuban percussionist under study
performing the musical examples and other material

You can choose any combination of the three to fit your personal style of learning.

Book

The book you’re reading now can be purchased at www.createspace.com/3500639 as a bound

paperback book. Alternatively, it can be viewed online and/or printed on your computer’s printer
from the website www.timba.com/percussion. Each book in the series contains music notation for

each exercise in both 8" notes (American-style) and 16" notes (Cuban-style), as well as explanatory
text and historical information. If you don’t read music and aren’t interested in the explanations and
history, you can choose to buy only the audio and/or video products for each volume.

Audio

The audio files are not included with each book. They’re available as separate downloadable
products from www.timba.com/percussion. For each notation example, there are two ultra-high

quality MP3 files. The first is recorded at normal tempo and the second in slow motion, usually
about 50 beats per minute. The audio files can be burned to audio CDs or played on an MP3 player.
If you have audio on your computer, | highly recommend taking advantage of the new generation of
computer programs that will allow you to change the tempo and/or key of any of these audio (and
video) files and to loop them to fit your style of practice. Particularly useful are: Amazing
Slowdowner™, Transcribe!™, and Emulator X® (see appendix for software download sites).

Video

The video product, like the audio product, is also available as a separate download from
www.timba.com/percussion. The video product for each volume contains one video file for each

chapter, with on-screen subtitles for each exercise. Also included with each video is a pre-
programmed .XSC file allowing you to use the inexpensive shareware program Transcribe!™ to view
and practice with slow motion video loops of each exercise.
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Beyond Salsa Percussion (www.timba.com/percussion), like its sister series, Beyond Salsa Piano

(www.timba.com/piano), is designed to double as both an instructional method book series and a

course in music history, music appreciation and record-collecting.

The first target audience is of course players of the instrument being studied in any given volume.
Some exercises are appropriate for near-beginners and others will be challenging to professionals.

The second target audience is arrangers, players of other instruments, dancers and listeners who
simply want to understand how Cuban music works, and how it’s evolved historically.

Volume 1 (to be released in 2011) is a beginners’ guide to all the instruments of the rhythm section.
It demonstrates the methods and notation systems used in the series, covering the most basic
patterns of each instrument in the various Cuban musical genres.

Each subsequent volume is devoted to a single musician, beginning with legendary drummer and
timbalero Calixto Oviedo.

Volume 2: Calixto Oviedo — Drums and Timbales: Basic Rhythms covers the rhythms that Oviedo
learned before he began his innovative career with NG La Banda, Adalberto Alvarez y su Son, Pacho
Alonso and other important groups. We present the basic rhythms, their histories, a survey of the
best recordings, and Calixto’s own unique ways of executing each one.

Volume 3: Calixto Oviedo — Drums and Timbales: Timba Gears breaks Calixto’s modern style down
into six major “gear” groups and analyzes each in great detail, explaining his approach to
improvising and the differences in the way he plays with different groups.

Volumes 4 and 5 deal with complete Calixto Oviedo drum performances of classic NG La Banda
arrangements such as Santa palabra, Echale limén, La bruja, Picadillo de soya and others. We break
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down the performances into a series of exercises, demonstrating how each of the six gear groups
studied in Volume 3 is applied, and explaining the elements specific to individual songs (such as
bloques and special rhythms).

Volume 6 and Beyond — Many additional volumes are planned with a wide range of important
Cuban percussionists, including a survey of bongd with ex-Paulito FG bongosero Carlos Caro.
Needless to say, we'll also be publishing volumes on timbales, congas, bass, synthesizer, guitar and
tres-playing to complete our survey of the Cuban rhythm section.
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Shown above are the first eight of nine current volumes. More are planned for 2011.

Beyond Salsa Piano (www.timba.com/piano) is a history and anthology of the role of the piano in

the Cuban rhythm section — from its first appearance to the present. In a broader sense, it’s a study
of the tumbao — the art of creating music from layers of repeating rhythmic and melodic phrases.
Whether these syncopated figures are called tumbaos, guajeos, montunos, riffs or vamps, this Afro-
Cuban concept lies at the heart of nearly every popular music genre from salsa to rock, funk, R&B,
hip-hop and jazz.

While presented as a set of method books, the series doubles as a history course and record-
collecting guide for listeners, dancers, and players of instruments other than the piano.
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Perhaps the most important goal of the series is to provide a comprehensive understanding of how
tumbaos are constructed, their central role in the texture of Latin music of all eras, and the endless
possibilities they provide for creative composing and arranging.

Volume 1 begins around 1900 and covers the origins of the tumbao concept using exercises adapted
from genres — such as changiii, danzdn, and son — which pre-date the use of piano as the primary
instrument for tumbaos in Cuban music. This material is designed to be playable by near-beginners,
players of other instruments, and arrangers seeking to acquire a basic facility on piano.

Volume 2 covers the period from 1940-1959, during which the piano became a constant and
dominant presence in nearly every Latin rhythm section and during which Cuban music had a
profound global influence on all forms of popular music. The difficulty level ranges from beginning
to intermediate.

Volumes 3 and 4 cover the eclectic period between the Cuban Revolution and the Fall of the Berlin
Wall — from 1959 to 1989. Volume 3 focuses on new rhythms such as mozambique, pilén, songo,
changlii-68 and batumbata created by groups such as Los Van Van, Irakere, Ritmo Oriental and
others. It also includes an extensive section on Afro-Cuban folkloric music and the ways that its
rhythmic time feels have influenced popular music piano tumbaos. Volume 4 focuses on the 1980s
as elements of pre-Revolution Cuban music were reintroduced as a result of interaction with the
global salsa scene.

Volume 5 introduces the timba genre that began in about 1989. It includes a history and
discography of the era, a detailed description of rhythm section “gears”, a list of the most important
piano innovations of the 1990s, and finally a series of 32 instructional tumbaos, all on the same
chord progression, demonstrating these innovations. There’s also a massive appendix which
analyzes the chord progressions of hundreds of timba tumbaos by all the major groups.

Volumes 6, 7, 8 and 9 — These four volumes cover the style and career of lvan “Meldn” Lewis, the
phenomenally innovative pianist who played with The Issac Delgado Group from 1995 to 1998.

Volumes 10, 11 and 12 — These volumes, scheduled for release in early 2011, study the style of
César “Pupy” Pedroso of Los Van Van and Los Que Son Son.

Volumes 13 and Beyond — Among the other pianists we hope to cover are Juan Carlos Gonzalez,
Tirso Duarte, Rolando Luna, Rodolfo “Peruchin” Argudin, Tony Pérez, Chaka Napoles, Sergio Norofia,
Yaniel “El Maja” Matos and many others.



Introduction to Volume 2

Calixto Oviedo with Juan de Marcos and the Afro-Cuban All Stars — Napa, California — 2010 — photo by Tom Ehrlich

Volume 2 of the series, the first volume on Calixto Oviedo, is analogous to the second volume of The
Tomds Cruz Conga Method. We asked Calixto to demonstrate the traditional Cuban rhythms which
most influenced his later innovations, and which are most useful to him in his current range of
touring and recording situations. For example, with Juan de Marcos and the Afro-Cuban All Stars,
Calixto regularly performs authentic danzén (Chapter 1) and chachacha (Chapter 2), while other
rhythms, such as mozambique (Chapter 3) and pildn (Chapter 4) have more subtly influenced the
creation of the modern style he developed with Adalberto Alvarez, NG La Banda, and continues to
use with La Jugada and the various groups that he leads in Europe.

In each chapter, we study the history, development and discography of the genre under study,
highlighting the groups and recordings that have resulted in that genre withstanding the test of time
and solidifying its place in history, and as an influence on later genres and players. The rhythms
covered in Volume 2 are danzdn, chachachd, mozambique, pildn, simalé, and upa-upa.

Volume 3 will be devoted entirely to Calixto’s modern style, with each chapter covering a separate
element of that style. For example, how he plays behind the cuerpo (marcha abajo), behind the
coros (marcha arriba), behind the timba breakdowns (presiéon and bomba) and so on.
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Beyond Salsa Percussion, Volume 3 o Calixto Oviedo ® Drums and Timbales: Timba Gears

Having completed our survey of the rhythms that most influenced Calixto’s development, our next
volume will consist of an in-depth study of his modern style, preparing the way for our final
volumes, which will show how that style was adapted in the historic recordings that Calixto made
with NG La Banda, such as Santa palabra, Echale limén, El trdgico, Picadillo de soya, and La bruja —
masterpieces that rank among the best and most influential recordings in Cuban music history.

The next volume breaks down Calixto’s style into six major “gear” categories: marcha abajo, marcha
arriba, marcha de mambo, muela, presion and bomba. First we’ll present these from a generic point
of view and explain how they fit into the styles of almost all post-1990 Cuban bands, then we’ll
study Calixto’s unique and extremely varied ways of executing each one, using the same system of
notation, audio and video loops, and controlled improvisation analysis that’s served us so well in
this volume.

Whether your current playing situation is timba, salsa or a more traditional Cuban genre, you'll be
able to see how what you’re doing now can be understood in terms of gears, and how you can use
Calixto’s gears — and his specialized ways of approaching them — to enhance both your personal
drumming style and the style of your band.
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How to Use the Videos
(Also See Video Looping Section at the end of this document)

Note: This section is being written in 2010 and describes the 8.0 version of the Transcribe! program. We
anticipate that drummers will still want to learn to play like Calixto Oviedo long after the technical
information and programs described in this chapter are obsolete. If you’re reading this in 2013, there are
probably many wonderful new ways to slow and loop these videos.

Some of the best drummers we know are completely computer-phobic, so we’ve gone to great
lengths to design the computer-related features in a way that will let you use them without having
to understand them.

Extracting the Videos

After purchasing the video companion product from www.latinpulsemusic.com, download the .zip

file to your hard drive and unzip it. It will contain two files for each video: a large .MQOV video file
and a very small .XSC file designed to be used with the third-party program Transcribe! Make sure
to leave all these files in the same folder. After extraction, you can delete the .zip file.

Using the Videos without the Transcribe! Program

There is one video (a .MOV file) for each chapter of the book. In each, Calixto talks about the rhythm
and plays the demonstrations from which we created the notated exercises and looped audio files
(a separate downloadable product). These movies should play automatically on all Macs and most
PCs. If they don’t play or if you don’t like your video player, we've had great luck with the freeware
VLC Player from www.videolan.org, which will open almost anything and has various nice features

like slow playback with audio.

Acquiring the Transcribe! Program

To take advantage of the incredible added value of the .XSC files we provide with the videos, you'll
need to install Transcribe! from www.seventhstring.com/xscribe/download.html (if the link doesn’t

work, just do a Google search for “Transcribe!” or “seventh string”).

Transcribe! costs S50 (35 Euros), but you can use it for free for a full month, which should be plenty
of time to decide if the extra features are useful to you.

Using the .XSC Files with the Transcribe! Program

Transcribe! has many windows. There’s one main window for each .XSC file. You can have more
than one .XSC open at once, which can be convenient, but it can also be confusing. So, we
recommend closing each .XSC using the File menu’s “Close” command before opening the next until
you get used to the program.
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The main window looks like this:

=1oix]

L Transcribe! - 2-3-Beyond Salsa Percussioz-¥ol. 2-Chpt. 3-Mozambique.ssc
Fi= View Play Markers Text Window “Relp

FAPIEIN R o ¢ |E] A FIEIEE = | rx EY < )t )

< >

Analysed section starks at 1m 57.785 and is 0.339 seconds long. Spectrum koo messy, or out-of-tune notes,

Transcribe! has many complex features, but there are only a few very simple things you need to
know in order to use the .XSC files that we’ve carefully created to help you practice along with
Calixto. Arrow #1 points to the tempo buttons. If you click, for example, the 50% button, the video
will play at half speed, but with the correct pitch. If you’re over 25 years old, you’ll probably agree
with me that this is a true miracle of technology that previous generations of musicians would have
given almost anything to acquire. You can also change the tempo with the slider below. If you
wanted to change the pitch, you could do that too, but that feature will be much more valuable to
your bassist friends.

i Transcribe! - 2-3-Beyond Salsa Percussion-Yol. 2-Chpt. 3-Mozambique.xsc Arrow #2 points to the Window menu, which
you’ll need to get to the wonderful video loops

File View Play Markers Text | Window Help

[_I_-\l_l_l ‘ v Audio Effects and Controls
J X|=|d Q\E NI UBOEReS flars OnTOp we’ve created for each exercise.

~ —  SoundFile Info
| Bring All to Front

rnte oy The first item, “Audio Effects and Controls” will

bring up the window that contains the loops. The second item, if checked, will keep that window on
top of all other open windows.

If Audio Effects and Controls isn’t already checked, check it, and you should see the window in the
next diagram. If you don’t, check the taskbar of your PC or the Dock of your Mac for the Audio
Effects and Controls window.
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Monokaraoke | EQ | Tuing | Transpaskion | speed Msc |
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e B E ot Now — all you have to do is click on the colored
rectangle that corresponds to the exercise you’re
studying and you’ll see Calixto playing it over and over at whatever speed you choose in the main
window. If you have a better sense of timing than your faithful author, note that you can make tiny
changes to these loops and even make more loops of your own, saving them, and labeling them as
you choose. This tutorial only touches on the features you absolutely need, but the program comes

with a Help file that will guide you through the advanced features.

Mozambique), there’s a scrollbar. The loops are
color-coded by type. You can change the colors
by right-clicking on the colored rectangle.

For now, we only need to cover one more thing: we need an easy way to stop and
o " start the video. It can be frustrating having to use the Audio Effects and Controls
window to choose your loop and the main window to stop and start it, but Transcribe!
has a very handy solution for this.

\ Choose Keyboard Commands from the File menu. If you explore this
feature, you’ll discover that you can create all sorts of complicated commands, but for now we only
need one — a global command which routes Control+Spacebar to Play and Stop.

In the next dialog box, find “PlaySpacebar” in the
“Press” column and highlight it with the mouse.

tmwﬁ-mr
[ g e o )|

liE M.luﬂjsblv Defauk H H “" ” H

. PappaseToode AR Next, click in the “Keystroke” field at the  bottom,
PlayStop

Conrolo i - | hold down the Control key and press the spacebar (or

(Control 1 Speedl00

o2 Sooun e use any other combination that appeals to you).

3 SalectionWindomiight

(Control 3 Spee

Conkrol 4 SpeedZS

(Control 7 SpeedMnus3

et iy

Finally, click “Create or Edit Global Shortcut”, then
click OK and you’re done.

ot | ommrdvhenrdsed oone> Because it’s a global command, this means you can
il ki stop and start your video no matter what window is

_cemasmesset | frontmost on your computer, even if it’s another
program. This means that you can keep the Audio Effects and Controls window at the front, letting
you switch loops, and start and stop the video by simply holding down the Control key on your

computer keyboard and pressing the spacebar. Voilal

Keystroke: [ Ncemal:Control Space Global:32,C
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“Global” means that the key command will work for Transcribe! even when you’re in another
program, which can really make your life a lot easier. You could also be transcribing Calixto’s
performance into Finale or Sibelius and stop and start the video with control+spacebar while your
mouse is clicking in the notes and rhythms you’re transcribing.

Troubleshooting

“Transcribe! says it can’t find the .MOV file.”

If you keep the .MOV and .XSC files in the same folder, the video should open right up with no problem, but if you
get an error message saying the .MOV file can’t be found, OK the message and then go to the File menu shown
above and choose “Import sound file ...” — then simply navigate to the correct folder, find the .MOV, and save the
.XSC file so you won’t have this problem again.

“There’s no video window.”

Look in the View window and make sure that “Show Video” is checked. Sometimes it gets unchecked.

“The audio and video aren’t quite in sync!”

At the bottom of the Video window is a slider. It nudges the video to audio sync in very small increments.

“l don’t like the loop points!”

Enlarge the video display part of the main window, then zoom in until you can see each drum stroke in the sound
wave. You'll be able to see exactly where I've set the loop. To change it, use the right mouse button or (hold the
control key and use the left). This will let you drag the edge without losing the rest of the selection. When you get
it just right, right-click on the name of the loop in the Audio FX/Misc window and choose “Store” to save the new
loop over the old one. Then use “Save as ...” to save your own custom copy of the .XSC file. You can always go
back to the original. These .XSC files are extremely small and you can save as many as you like.

“What happened to the window with the list of loops?”

This window also sometimes mysteriously disappears. Just look in the Window menu and make sure “Audio
Effects and Controls” is checked. If it is, try unchecking and re-checking it. You can also look for it in the taskbar if
you’re using a PC. Once you find it, remember that you have to be in the Misc tab to see the loops.

“l can’t read the whole name of the loop.”

Different computers have different font settings, so if you can only see the beginning of each name, just hold your
mouse over the name and the full name will pop up. You can also right-click or control-click to change the name.

“When | try to change the loop points | lose the whole selection.”

If you hold down the right-click button, you can drag the edge of the selection freely.

“When | make my own loop, | hear a little click at the loop point.”

Hold down control and press the right arrow key on your keyboard to zoom way in. You’ll be able to see if your
loop is catching a little bit of a louder sound that begins just after the loop end. Try to make loops which start at a
loud sound and end right before that loud sound comes around again.
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Appendix 4: For Further Study

Suggested Reading

Earlier Volumes of this Series:
Beyond Salsa Percussion, Vol. 1 — The Basics of the Cuban Rhythm Section, by Kevin Moore

Later Volumes of this Series:
Beyond Salsa Percussion, Vols. 3, 4, and 5 — Calixto Oviedo, pts. 2, 3, and 4, by Kevin Moore

Overview:

Cuba and its Music, by Ned Sublette, Chicago Review Press

The Clave Matrix, by David Pefalosa, Bembe Books

Salsa Guidebook for Piano & Ensemble, by Rebeca Mauledn, Sher Music
www.timba.com

Discography:
Cristdbal Diaz-Ayala (http://latinpop.fiu.edu/discography.html)

www.timba.com

Danzén and Chachacha:
Un trio inseparable (instructional dance video) by Roberto Borrell, Boogall Productions

Drum Methods:

Changuito: A Master’s Approach to Timbales, by Chuck Silverman, Manhattan Music Publications
Yoel Pdez Método (abmusica.es)

The New Method for Afro-Cuban Drumming, by Jimmy Branly, Hudson Music

Conversations in Clave, by Horacio “El Negro” Herndndez, Alfred Publishing

Melodic Drumming, by Raul Valdés

Rhythmic and Timbral Concepts :
The Conga Drummer’s Guidebook, by Michael Spiro, Sher Music (www.latinpulsemusic.com)

Rumba Quinto, by David Pefalosa, Bembé Books

Timba:
The Tomds Cruz Conga Method, by Tomas Cruz, Kevin Moore, Mike Gerald & Orlando Fiol, Mel Bay
Beyond Salsa Piano, Vols. 5-9, by Kevin Moore (timba.com/piano)

www.timba.com

Piano and Cuban Music History:
Beyond Salsa Piano, Vols. 1-9, by Kevin Moore
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http://www.timba.com/encyclopedias/2-discographies
http://www.abmusica.es/
http://www.timba.com/piano

Suggested Listening to Prepare for Subsequent Volumes (Links go to Audio Excerpts)
** indicates audio preview and download is available on www.latinpulsemusic.com as of 2010.

This list is chosen for both overall musical quality and relevance to future volumes of this series.

GROUP ALBUM DRUMMER LABEL
Paulito FG y su Elite Con la conciencia tranquila Yoel Paez Nueva Fania **
Paulito FG (El bueno soy yo) Yoel Pdez Nueva Fania **

Bamboleo

Yo no me parezco a nadie

Ludwig NUnez

Ahi Nama **

Ya no hace falta

Ludwig Nunez

Ahi Nama **

NAffo!

Ludwig Nunez

Ahi Nama

Charanga Habanera

Hey You Loca

Eduardo Lazaga

Magic Music **

Pa’ que se entere La Habana

Eduardo Lazaga

Magic Music **

Tremendo delirio

Eduardo Lazaga

Magic Music **

Charanguero mayor

Yulién Oviedo

Ciocan Music **

Live in the USA

Yulién Oviedo

Ciocan Music

Chan Chan Charanga

Pavel Diaz

Ciocan Music **

Danny Lozada

Tanto le pedi

Pepe Espinosa

Issac Delgado Rarities (Exclusivo para Cuba) Georvis Pico Ciocan Music

El afo que viene Jimmy Branly RMM

Con ganas Giraldo Piloto RMM

La primera noche Yuri Noguiera ARTEX**

La férmula Oscar Valdés Jr. Ahi Nama **
Manolin Para mi gente Alexis Arce Ahi Nam3 **

De buena fe Alexis Arce Blue Metro

Jaque mate Alexis Arce Caribe

El puente Reinier Guerra Ciocan Music **
Los Van Van Disco Azucar Changuito Quintana ARTEX **

Lo dltimo en vivo Samuell Formell QBADisc

Ay dios, ampdrame Samuell Formell Caribe Records**

Esto te pone la cabeza mala Samuell Formell Caribe Records **

Llegd Van Van Samuell Formell Pimienta Records **

Chapeando Samuell Formell Unicornio Records**
NG La Banda Enla calle Giraldo Piloto QBADisc

Simplemente lo mejor de NG

Calixto Oviedo

ARTEX (BIS) **

Echale limdn

Calixto Oviedo

various

En cuerpo y alma

Calxto Oviedo

Caribe
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http://www.latinpulsemusic.com/albums/show/75
http://www.latinpulsemusic.com/albums/show/74
http://www.latinpulsemusic.com/albums/show/36
http://www.latinpulsemusic.com/albums/show/37
http://www.latinpulsemusic.com/albums/show/345
http://www.latinpulsemusic.com/albums/show/323
http://www.latinpulsemusic.com/albums/show/325
http://www.latinpulsemusic.com/albums/show/340
http://www.latinpulsemusic.com/albums/show/255
http://www.latinpulsemusic.com/albums/show/64
http://www.latinpulsemusic.com/albums/show/348
http://www.latinpulsemusic.com/albums/show/61
http://www.latinpulsemusic.com/albums/show/356
http://www.latinpulsemusic.com/albums/show/351
http://www.latinpulsemusic.com/albums/show/349
http://www.latinpulsemusic.com/albums/show/346
http://www.latinpulsemusic.com/albums/show/350
http://www.latinpulsemusic.com/albums/show/72
http://www.latinpulsemusic.com/albums/show/246
http://www.latinpulsemusic.com/albums/show/396

GROUP

ALBUM

DRUMMER

LABEL

NG La Banda (cont.)

La bruja

Calixto Oviedo

Inspector de la Salsa

La que manda

Calixto Oviedo

Inspector de la Salsa

La cachimba

Calixto Oviedo

Inspector de la Salsa

En directo desde el patio

Calixto Oviedo

Inspector de la Salsa

Klimax Mira si te gusta Giraldo Piloto Eurotropical
Juego de manos Giraldo Piloto Eurotropical
Oye como va Giraldo Piloto Eurotropical

Klimax and Manolito

Concierto Eurotropical |

Piloto/Yuri Noguiera

Eurotropical

Manolito y su Trabuco

Directo al corazon

Carlos Rodriguez

Bembé Records

Contra todos los progndsticos

Carlos Rodriguez

Eurotropical

Marcando la distancia

Yuri Noguiera

Eurotropical

Para que baile Cuba

Roicel Riverdn

Eurotropical

Se rompieron los termometros

Roicel Riverdn

Eurotropical

Hablando en serio

Roicel Riverdn

EGREM

Los Que Son Son

Queé cosas tiene la vida

Bombon Reyes

EGREM

La buenagente

Bombon Reyes

Pimienta Records

Mi timba cerrd Bombon Reyes EGREM

Tranquilo que yo controlo Bombon Reyes EGREM
Revé y su Charangon Se sigue comentando Andy Fornet BIS**

Fresquecito Andy Fornet BIS**

De qué estamos Hablando Andy Fornet
Azlcar Negra Andar andando Maikel Zamora BIS**
Michel Maza Fieeesta Karel Pdez Envidia**

Que hablen los habladores Karel Pdez Envidia**
Angel Bonne Circunstancias Javier Ochoa EGREM

Bonne & Bonne Co. Carlos Leal EGREM
Havana d’Primera Haciendo historia Rodney Barreto EGREM
Various Gracias Formell Yoel Pdez, Georvis Pico | Ciocan**
Los Ases de la Timba Los Ases de la Timba Yerisloy “Jerry” Serrano | Envidia**

For suggested listening within the 1960-1989 time period, please see the Discography and Online Book sections of the
Timbapedia section of timba.com.

NOTE: The free downloadable preview PDF of this book, available at timba.com/percussion, has a version of this same

chart, but with fully-functional links so you can listen to free only excerpts of the songs from about half of these albums
but just clicking on the titles. Links don’t work in the eBook version, but in the free PDF.
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http://www.latinpulsemusic.com/albums/show/343
http://www.latinpulsemusic.com/albums/show/342
http://www.latinpulsemusic.com/albums/show/347
http://www.latinpulsemusic.com/albums/show/159
http://www.latinpulsemusic.com/albums/show/158
http://www.latinpulsemusic.com/albums/show/254
http://www.latinpulsemusic.com/albums/show/144
http://www.timba.com/encyclopedias/2-discographies
http://www.timba.com/percussion

Calixto’s Equipment

coow

PERCUSSION

o ® |
ViC FIRTH

b f,‘

BECAUSE SOUND MATTERS
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In 2009, Kevin began the Beyond Salsa Piano series, which has reached nine volumes as of this

writing, with several volumes on Pupy Pedroso coming in 2011 and many more in works on other
great Cuban pianists.

BEYOND SALSA PIAN BEYOND SALSA PIANO BEYOND SALSA PIANO
THE CUBAN TIMBA PIAN UTION THE CUSAN TIMBA PIANG REVOLUTION THE CUBAN TIMBA PIANG REVOLUTION
BEYOND SALSA PIANO iy 1 r *

THE CUBAN TIMBA PIAND IEM'DI}YH:IN
W

VOLUME 1 * BEGINNING
FHE ROGITS F Totl PN TUNSAG

VOLUME 2 » INTERMEDIATE OLUME 3 » INTERMEDIAT VOLUME 4 » INTERMEDIATE
EART CLMAN FUAND TURARACH: 13481 CUIRAN PO TUMRRAD: 19605078 UM P TUMBADY: 1971980

WEVIE MCRE KEVIN MOORE KEVIN MOORL KEVIN MOORL

BEYOND SALSA PIANO
THE CUBAN TIMBA PLANG REVOLUTION
BEYOND SALSA PIANO BEYOND SALSA PIANO BEYOND SALSA PIANO

THE CUBAN TIMBA PIAND REVOLUTION THE CUBAN TIMBA PIAND REVOLUTION THE CUBAN TIMBA FIAND REVOLUTION
-y . !

T - Yy i v
VOLUME 5 « ADVANCED VOLUME & » IVAN "MELGN"LEWIS, PT. 1 VOLUME 7 » VAN "MELONLEWAS, T, 2
ATAGGUCTION 10 ks VTR o T TRANSERITIONS WO o R TRANSCRSTION

=
VOLUME B = IVAN "MELON" LEWIS, PT. 3
WOTH §T NTY TRANLCRSPTIONES

KEVIN MOORE KEVIN MOORE KEVIN MOORE KEVIN MOORE

Free audio and notation samples, and links to the books, audio and video files can always be found
at www.timba.com/piano.

High resolution printable drum legends follow on the next pages.

20


www.latinpulsemusic.com/albums/show/2
http://www.timba.com/piano
www.timba.com/piano




Terminology Reference Chart

XXXX
X000
X000
0000
XoXo
oXoX
XooX
XooX
00X0
00Xo
000X
0000
000X
0X00
XooX
XOoXX
XoXo
Xoxo
XoXo
X0oXo
XooX
XoXo
0000

XXXX
X000
0000
X000
XoXo
oXoX
00Xo
000X
X000
X000
0000
00X0
00X0
0000
00X0
0XXo
XoXo
XOXX
XXXX
XXoX
0000
X000
XoXo

XXXX
X000
X000
0000
XoXo
oXoX
00X0
00X0
XooX
XooX
000X
0000
000X
0X00
XooX
XoXX
XoXX
XOXX
OXXX
XoXX
0X00
000X
0000

XXXX
X000
0000
X000
XoXo
oXoX
X000
X000
00Xo
000X
0000
00Xo
00X0
0000
00X0
oXXo
oXXo
XOXX
XOXX
0XoX
XoXo
X000
XoXo

all subdivisions

main beats

frontbeats

backbeats

onbeats

offbeats

3-2 son clave

3-2 rumba clave

2-3 son clave

2-3 rumba clave

bombos

ponches

bombo-ponche

quinto pulses

tresillo

cinquillo

baqueteo (2-3)

campaneo (2-3)
contracampaneo (2-3)

cascara (2-3) (accents underlined)
standard timba marcha kick
Charanga Habanera marcha kick
standard timba breakdown kick
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Group 1: Instruments with 1 Timbre

kick drum -

jam block ‘
cymbals ®

Group 2: Instruments with 2 Timbres

open drum: snare or timbal . I:I stick press on timbal or snare

open tom: high, mid or floor tom stick press on tom

sobao — open tone with finger tips sobao — muff tone with finger tips

ride bell ride cymbal

hihat closed

@ |
9 U
open bell A A heel of bell
- | =
X

® hihat open

Group 3: Instruments with Multiple Timbres

ghost stroke
rimshot
cross-stick

snare or timbal:

G hand stroke (muted)

=%

' hand stroke (open)

open, stick press, baqueteo stroke

toms:

D D muted (stick pres)

\®\ \®\ muted (baqueteo)
D

@ ‘ open

open, stick press, baqueteo stroke
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Video Looping and other Educational Software Issues

Looping is an art, not a science, and video-looping isn’t even an art. It’s just a clumsy and imperfect
way to help yourself learn faster. That said, it has the potential to help you learn a lot faster — a
whole lot faster. Earlier generations of drummers — even drummers from about a year ago — would
have died to have the abilities we have today. Recent software advances have been so amazing that
| felt compelled to use looping for this project, especially given the extremely improvisational nature
of Calixto’s style.

This book is being written in 2010. Hopefully by 2012, readers will laugh at this section because
seamless slow-motion looping will be built into every program. But for the benefit of our 2011
readers, here’s an assessment of the current “state of the art”.

PC Versus Mac Issues

The two most common formats for video on computer are WMV and .MOV. WMV files will play on
any PC, but to play them on a Mac, you have to find and install Windows Media Player for Mac.
MOV files play natively on a Mac, but on a PC they often require the installation of QuickTime. The
best free program we’ve found for opening just about anything on either type of computer is VLC
Player from videolan.org. It also has the ability to slow video without changing the pitch.

Another frequently-encountered PC-Mac issue is our own eBooks, which only work on PC, so Mac
users will need to either buy the hard-copy book or print out the eBook from a friend’s PC.

Audio Looping

If you’re only interested in looping audio, my miracle tool of choice is Emulator X from emu.com,
which we used to make all of the audio files for this series. It analyzes a whole track of music,
complete with barlines, beat numbers, subdivisions and a running display of the tempo. You can
instantly grab any section to loop it while it plays, and the looping is absolutely seamless. But, it
doesn’t do video, and it doesn’t run on a Mac. As a PC user, | haven’t fully explored Mac looping
tools, but if | were stuck on a desert island with only a Mac, the first thing I’'d try would be Sony
Acid. The previously recommended programs Transcribe! and AmazingSlowdowner will also do
looping but you have to set the loop points by hand. The Calixto Oviedo audio and video companion
products use audio loops created with Emulator X and video loops created with Transcribe!.

Video Looping

Audio loopers are usually horrified when they start trying to loop video because video is shot in
“frames”, not samples, so you can’t zoom in nearly as far. Instead of 44,100 samples per second,
you're limited to about 30 frames per second. Ouch. Nevertheless, with advent of a new program


http://www.videolan.org/
http://www.emu.com/

called Transcribe!, video looping has reached the point that it’s just too useful to ignore — especially
for drummers, for whom mastering blazing fast 13-stroke rolls is just part of business as usual.

The reason an audio looping program like Emulator X can make absolutely perfect, seamless loops is
that with audio, you can zoom to, and edit at, the sample level. A CD track has 44,100 samples per
second and with almost any audio program you can zoom all the way to a single sample and set the
beginning and end of your loop right a the “zero crossing” — where the wave is temporarily silent.
You start at the zero crossing before a loud bell or snare drum stroke, and end your loop at the same
point in the cycle, one or more claves later. Emulator X does this automatically — your mouse
automatically grabs each sound impulse at the perfect spot, and you can even grab measure and
beat markers so you don’t have to worry about understanding the pattern. Looping from bar 2 to
bar 6 will always produce a perfect, in-time loop. Then you just slide it backwards and forwards, a
16™ note at a time, until you find a playable and musically satisfying loop.

The opportunity to watch the body language of a master drummer like Calixto Oviedo is also
immeasurably valuable. The looseness in his wrists and ankles, and even his facial gestures provide
intangible information to your subconscious mind that could never be explained in words or
notation.

Slowing Down Audio and Video

Since the beginning of recording technology, musicians have searched for ways to slow down music
to steal the licks. Charlie Parker famously let his Victrola wind down as he practiced along with the
solos of his idol, Lester Young. As the tempo slowed, the pitch also dropped, forcing him to
transpose the solo into each of the 12 keys — something that serendipitously helped him develop
some of the facilities he used to invent the bebop style of jazz. John Coltrane adopted a similar
approach when he, in turn, studied Parker’s music and a whole generation of saxophone players did
the same thing as they attempted to learn Coltrane’s solos on Giant Steps and other compositions.

If anyone ever tries to convince you that copying your role models will make you an unoriginal
player, simply listen to recordings by Frankie Trumbauer, Lester Young, Charlie Parker, and John
Coltrane, four incredibly original innovators who began by shamelessly stealing anything and
everything they could from the previous person on the list. Stealing licks won’t make you an original,
but every original began by stealing licks.

By the 1960s, musicians had turned to tape recorders, recording the source material at 7.5 IPS
(inches per second) and playing it back at 3.75 IPS. This had the advantage of keeping the music in
the same key, but it was a full octave lower, causing major timbral distortion. Bass players did the
opposite to bring the bass line up into the singing range, but this had the two undesirable side-
effects of speeding up the tempo and making the singers sound like chipmunks.



Finally, software engineers discovered the “holy grail” and figured out how to slow down the tempo
without changing the pitch. At first, this introduced a different, and often even nastier type of
timbral distortion, but it's improved every year to the point that even Windows Media Player and
its Mac equivalents can slow down both audio and video with astoundingly good fidelity.

In my opinion, the best quality audio slow-down is achieved by an inexpensive program called
Amazing SlowDowner, which we used to create the slow audio files included with this book’s audio
companion product. In 2010, the same company released a video slow down program called
Ultimate DVD Player. The quality is excellent and it works on Mac and PC but the downside is that it
only plays DVD files, so it’s not useful to us for video.

| could continue reviewing software for many more pages, but by the time you read this, the
situation will have changed (for the better no doubt), so to make a long story shorter, I'll jump to
the video solution | chose for Beyond Salsa Percussion, Transcribe! by seventhstring.com.

Transcribe!

Transcribe! loops video as well, and as easily, as anything I've found and it has two additional life-
changing features that as of this writing are unique:

e |t allows you to easily create and store multiple loops in the same video file.
e It allows you to actually export a slowed-down, looped video to a new video file.

Transcribe! works with both Mac and PC, costs only USS50 and has a free one-month trial during
which time all of its features are available. It doesn’t let you set loop points as easily as Emulator X,
but it’s surprisingly easy and of course, it works with video. The fact that we can ship the video with
multiple pre-created loops will also save your many hours, allowing you to play along with Calixto in
slow motion with a minimum of setup time.

The downside of Transcribe! is that it only works well with .MOV files, so some PC users might need
to install QuickTime (a free download from apple.com).

The Beyond Salsa Percussion Solution

When you buy the video companion product for a book in this series, you get a .MOV file for each
chapter that features multiple clips of the featured artist, (in this case Calixto Oviedo), playing and
talking about the rhythm being studied. You can watch it with any computer, and study or slow it
down with any software you have available. If you do choose to use Transcribe!, we include a
special .XSC file with pre-programmed loops. A detailed tutorial with illustrations and a
troubleshooting guide — designed for non-computer geeks — is included in Appendix 3 of this book.

You should be able to get instant gratification, however, by simply installing the free trial of
Transcribe!, making sure the .MOV and .XSC files are in the same folder on your computer, and


http://www.seventhstring.com/xscribe/download.html
http://www.apple.com/

double clicking the .XSC file. If necessary, use the File menu’s Import Sound File ... command to
point Transcribe! to the .MOV file. Then use The File menu’s Save command to make sure the
program remembers which .MOV file to use the next time you open it.

Next, go to the Windows menu and open the Audio Effects and Controls window, then click on the
Misc tab. In the left half of the window, you’ll see colored rectangles named for each exercise in the
chapter. Simply click on one of these and a pre-set loop will be loaded of just that exercise. You can
then use the speed controls to slow it down as much as you want. If you don’t like the exact timing
of the loop or want to add new loops of your own, you can do this easily by right-clicking the wave
form display and dragging the edge of the loop while the file plays. If you scroll down the list of
saved loops, you can right-click (or control-click on a Mac) to store and name your new loop.
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